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Installing KNIME Analytics Platform

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system. KNIME Analytics Platform can be installed on Windows, Linux, or

macOS.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.

Figure 1. KNIME Analytics Platform available installers
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4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

The following operating systems versions are supported:

• Windows

◦ Windows 10, 11

◦ Windows Server - 2016, 2019, 2022,

• Ubuntu 20.04 LTS and 22.04 LTS and derivatives

• RHEL/CentOS/Rocky Linux 8, 9

• macOS (12 and above - macOS x86_64 Intel) and M1 (macOS arm64 - Apple silicon)

(only the last two major versions are supported)

◦ macOS 12: Monterey

◦ macOS 13: Ventura


Also check the KNIME Getting Started Guide and the KNIME Analytics Platform

User Guide.

Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.
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On MacOS: To locate knime.ini on MacOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (MacOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

If you want to add capabilities to KNIME Analytics Platform, you can install extensions and

integrations. The available extensions range from free open source extensions and

integrations provided by KNIME to free extensions contributed by the community and

commercial extensions including novel technology nodes provided by our partners.

The KNIME extensions and integrations developed and maintained by KNIME contain deep

learning algorithms provided by Keras, high performance machine learning provided by H2O,

big data processing provided by Apache Spark, and scripting provided by Python and R, just

to mention a few.

Install extensions from:

• KNIME Hub:

◦ Search for the Extension or Integration you want to install in the search bar

◦ Click Extensions on the results page

◦ Click the extension you want to install, and from the extension page and drag and

drop the squared yellow icon, shown in Figure 2, to the KNIME Analytics Platform.

A window will open asking if you want to search and install the extension or

integration. Click Yes and follow the instructions.

Figure 2. Install the KNIME Integrated Deployment Extension from KNIME Hub

◦ Restart KNIME Analytics Platform.

• KNIME Analytics Platform:

◦ Access the info page by clicking the info icon in the top right corner of the KNIME

Analytics Platform.

◦ Under Resources scroll down to Install Extensions and click the Install Extensions

button The dialog shown in Figure 3 opens.
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Figure 3. Installing Extensions and Integrations from KNIME Analytics Platform

◦ Select the extensions you want to install

◦ Click Next and follow the instructions

◦ Restart KNIME Analytics Platform.

The Install Extensions menu provides the extensions that are available via the update sites

you have enabled.

To uninstall an extension, scroll to the bottom of the info page and click the About KNIME

button, and then Installation Details. A dialog shown in Figure 4 opens. Now, select the

extension that you want to uninstall, and click Uninstall….
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Figure 4. Uninstalling Extensions and Integrations
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Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

Do this by:

1. Clicking the info icon in the top right corner of the KNIME Analytics Platform to access

the info page.

2. Scroll down to Install Extensions and click the Check for updates button. In the dialog

that opens, select the available updates you want to install and then click Next.

3. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, click the cog button in the top right

corner of the Analytics Platform. It opens the Preferences dialog. Select Install/Update →
Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 5. Available Update Sites

KNIME Analytics Platform 5.1 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

Community Extensions (Experimental):

Provides additional extensions created by

the KNIME community.

KNIME Community Extensions (Trusted):

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Update Site 5.1: Provides

extensions created by KNIME partners.

KNIME Analytics Platform 5.1 Update Site and KNIME Community Extensions (Trusted) are

KNIME Analytics Platform Installation Guide

© 2023 KNIME AG. All rights reserved. 8



enabled by default.

Adding External Update Sites

To install extensions that are not part of the above update sites, click Add to manually add

the relevant update site, inserting the Name and Location as shown in Figure 6.

Figure 6. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If your working environment has limited internet access or you receive an error message

“Proxy Authentication Required” when connecting to a remote update site (provided by a

URL), you can install extensions from a local zip file.
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1. Download KNIME update sites as zip files at the following links:

◦ KNIME Analytics Platform Update Site

◦ KNIME Community Extensions

◦ KNIME Partner Update Site 5.1

2. Save the zip file containing the extensions to your local system

3. Click the cog button in the top right corner to open the Preferences dialog. Select

Install/Update → Available Software Sites and enter the path to the zip file by clicking

Add → Archive… as shown in Figure 7.

Figure 7. Adding Update Sites from Zip Archive


If the same extensions are provided by a URL, you will first have to disable

the update site by disabling it in the list.

4. Now click Apply and Close



If the same extensions are also provided by a remote update site, you will

first have to disable that update site by deselecting its entry in the

Available Software Sites dialog and confirming via Apply and Close.
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Release notes and changelogs (KNIME
Analytics Platform 5.1)

Release notes and detailed changelog for v5.1.x releases

KNIME Analytics Platform 5.1.0

Release date: July 19, 2023

Release notes

• Modern UI is the new default perspective for building and editing workflows for new

KNIME workspaces. The old/classic user interface is still available and fully supported,

reachable via the info page by clicking the info icon in the top right corner of the KNIME

Analytics Platform.

• Upgrades from earlier versions, e.g. KNIME Analytics Platform 4.7.x are not possible. A

fresh new installation is required. Shell scripts that assist with the upgrade are available

for Windows and Linux and macOS.

• The KNIME Labs Extension “KNIME Deeplearning4J Integration” has been marked as

(legacy) and will be deprecated in a future version. Users are recommend to use other

deep learning integrations such as Keras or Tensorflow.

• The KNIME Javascript views have received a (JavaScript) suffix to make them more

distinguishable from the new views.

• The underlying Eclipse version has been updated from 2022-06 to 2023-03, incl. a

number of library updates (e.g. Birt 4.9 → 4.13).

• The library to process Json documents has been updated to a the new namespace

jakarta.json - 3rd party node extensions depending on it will need to be adjusted

(currently causing compilation errors). Workflow users depending on the class names

in, e.g. a Java Snippet node, might need to adjust their script (some fixing has been

done but probably only fixes 80% of the use cases).

• The library to make REST requests (CXF) was updated to version 4.

• The option to select the asynchronous HTTP client implementation in REST client

nodes was removed.

• Component execution is done slightly differently: A component’s “output node” will

require all nodes within a component to be executed before execution succeeds.

Equally, it will automatically be reset if any individual node is reset.
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• The version of the underlying workflow storage format has been updated, causing all

workflows to be completely re-saved when modified.

• Workflow Description: Title field has been deprecated (disambiguation between file

names, workflow title and workflow name).

• XGBoost: Current limitation on Linux when passing numeric parameters (to be fixed in a

bug fix release).

• Integrated Deployment: Workflows captured in loops require no “static” inputs, causing

workflows to fail when collected in tables (hints at ill-designed workflows).

• All “(local)” views have been marked as legacy (replaced by modern visualization

nodes).

• JFreeChart extension (local visualization) has been marked legacy and removed from

the update site (still installable).

• “Headless” execution of workflows, e.g. on KNIME Server on Linux or via batch

execution require an X Display (e.g. virtual framebuffer). For details see the KNIME

Server documentation.

Changelog (KNIME Analytics Platform 5.1.0)

New nodes

• UIEXT-470: Create ROC Curve node

• UIEXT-464: Create Parallel Coordinates Plot

• UIEXT-460: Create scatter plot matrix

• AP-20648: Data App Deployment Creator

• AP-20647: Service Deployment Creator

• AP-20593: Version Creator

• AP-20546: OAuth2 Authenticator (Password)

• AP-20545: OAuth2 Authenticator (Client Credentials)

• AP-20526: Box Authenticator

• AP-20425: Number Format Manager

• AP-20151: Box Connector

• AP-20065: Node List Extractor (extracts lists of nodes from current installation - part of

testing extension)
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• AP-20004: Cell Updater: Inject a new value for a single cell in a table

• AP-19950: Row Aggregator (simplification of GroupBy node)

• AP-19921: Table Splitter: according to a split criterion, define a row at which to split the

table into top and bottom parts

• AP-19673: Data App Deployment Creator

• AP-19623: Table Updater: update values where row&column match

• AP-19621: Cell Extractor: extract the a single cell as table and flow variable

• AP-19620: Table Cropper: select a range of rows and columns to keep

• AP-18888: ZIP Archive Connector

• AP-18740: OAuth2 Authenticator

• AP-17353: String Replacer (Dictionary) node: Extended functionality and table input port

for dictionary

• AP-13269: Value Lookup (supersedes "Cell Replacer" node with functionality similar to

Excel’s VLOOKUP)

Enhancements

• UIEXT-1039: Add '# Missing values' to Statistics View

• UIEXT-581: Indicate filtered items in TwinList

• UIEXT-533: Add unknown fields option to TwinList

• UIEXT-499: Fixed position for search and filter buttons

• UIEXT-402: Image generation for new visualisation nodes

• NXT-1836: Add dragged component from the hub to the workflow

• NXT-1835: Open dragged workflow from the hub

• NXT-1760: Display preferences button in application header

• NXT-1711: Switch between spaces in space explorer side panel

• NXT-1710: Edit workflow meta data

• NXT-1669: Display re-execution indicator for supported nodes

• NXT-1656: Replace node by dropping an existing node on another node

• NXT-1639: Port view with table spec and basic table statistic

• NXT-1634: Display unsaved changes for workflow tabs

• NXT-1632: Export workflow
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• NXT-1587: Context menu inside the space explorer

• NXT-1572: Allow opened workflows to be deleted

• NXT-1499: Space explorer for local spaces and KNIME Hub Spaces

• NXT-1435: Display summary, issue and resolutions in error message tooltip

• NXT-1425: “Get started” page with workflow examples, local spaces, and hub spaces

• NXT-1402: Node repository based on the starter nodes or all nodes

• NXT-1369: Info page for “About”, “Install extensions“, “Perspective switch”, …

• NXT-1279: Enable AP to be started by default with the “Modern UI” perspective for new

workspaces

• NXT-1262: Search for compatible nodes inside the quick nodes adding panel

• NXT-481: Insert node on a connector by dropping it onto a connector

• NXT-238: Basic rich text workflow annotation

• NXT-104: Edit node label text

• BD-1215: (Big Data Extensions): Add support for native Databricks driver version

>=2.6.25

• AP-20675: SMB Connector node: Update smbj library to version 0.12.1

• AP-20599: HTML Cell Type: Hyperlinks and coloured text for views and Reporting

(Labs)

• AP-20585: REST Web Service nodes: Remove option to use asynchronous HTTP client

(misses functionality, has poor performance)

• AP-20580: (Python) Support Port type inheritance in Python nodes

• AP-20571: REST Web Service nodes: Add dynamic credentials input port

• AP-20538: DB framework with support for Kerberos constrained delegation for multi

host databases

• AP-20537: Kerberos constrained delegation with support for multi host services

• AP-20536: DB nodes should not block a worker thread from the thread pool when

waiting for the DB connection

• AP-20500: Update Apache CXF to 4.0.1 for supporting Jakarta namespace

• AP-20481: Switch from javax.json to jakarta.json

• AP-20402: Reporting (Labs): Generate reports from component views, similar to Data

Apps, incl. multiple report utility nodes (e.g. PDF Writer)

• AP-20358: Update AWS Java SDK to version 2.20.42
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• AP-20354: Improved handling of throttling in SharePoint Online nodes

(Connector/Lists)

• AP-20340: Google Analytics Query node: Support for dimension filter expressions

• AP-20309: Twitter Streaming node: Deprecated due to Twitter’s API policy

• AP-20295: Update Microsoft Graph SDK to version 4.59.0

• AP-20258: Add image output port type to Python node API

• AP-20245: (Python) Add ConnectionPortObject that enforces connected nodes to use

the same Python process, so that they can reuse a connection/sess

• AP-20242: (Python) Allow hiding advanced sections=ParameterGroups

• AP-20219: REST Web Service nodes: Add option "Fail on missing header value" (e.g.

when credentials flow var does not have password)

• AP-20206: (Python) Add access to CredentialProvider from Python’s ExecutionContext

• AP-20181: Workflow Reader node: Improve error message when reading a workflow

that contains non-installed nodes

• AP-20105: KNIME Deeplearning 4J integration marked as "(legacy)" — see release notes

for details

• AP-20092: Google Sheets Writer/Updater/Appender: Add "Write raw" setting in dialog

• AP-20086: Web UI for Unpivoting

• AP-20079: Add advanced setting "Update domains of all columns" to all WebUI nodes

that change data ranges

• AP-20048: (Python) Support full column filter in Python extensions

• AP-20016: Node API with keywords — used in (fuzzy) node search, e.g. Excel Reader

also matches "Microsoft" or "Spreadsheet"

• AP-20002: Update of underlying Eclipse version from 2022-06 to 2023-03

• AP-19990: Web UI for String to Number

• AP-19980: Web UI for Column Lagger

• AP-19979: Web UI for Reference Column Filter

• AP-19978: Web UI for Column Merger

• AP-19977: Web UI for Reference Row Filter

• AP-19976: Web UI for Table Transposer

• AP-19968: Web UI for Column Appender

• AP-19958: Call Workflow nodes: Enhance node description for default execution

contexts
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• AP-19914: Extension API: New API method to send 'rich' messages from NodeModel to

UI (improved error and warning messages)

• AP-19882: Google Analytics nodes: Migrate from Reporting API to Data API

• AP-19860: Web UI for Column Renamer (dictionary) (was Insert Column Header)

• AP-19859: Web UI for Column Header Extractor node

• AP-19858: Web UI for Double to Int node

• AP-19857: Web UI for Number to String node

• AP-19856: Web UI for the Duplicate Row Filter node

• AP-19855: Web UI for Column Renamer

• AP-19854: Web UI for Column Filter node

• AP-19851: Web UI for String Replacer

• AP-19799: Container Input/Output nodes: Improve node descriptions

• AP-19703: Add support to Column Expressions node for KNIME Space file system

• AP-19698: Support multi-threaded reading of CSV files

• AP-19619: Call Workflow nodes: Support execution of workflows deployed on the

KNIME Hub

• AP-19526: REST Web Service nodes: Add proxy configuration options

• AP-19504: Do not use packages from "anaconda" channel when using "Create new

environment" on Python preference pages

• AP-19298: DB Connection Closer node: Dynamic input ports

• AP-19140: Python Node Extension: Support sharing environments

• AP-19132: Support PNG Cells in the Columnar Backend and Python

• AP-17204: Read Excel Sheet Names node: Support for XLSB files

• AP-16261: Support JSON cells in Columnar Backend and Python

• AP-15564: Implement ValueFactory for FileStoreCells and support XML cells in

Columnar Backend and Python

• AP-14848: Microsoft Access Connector node: Support password protected files

• AP-12191: Automatic closing of idle database connections

Bug Fixes

• UIEXT-672: Current JS Views overlap other views in components
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• AP-20541: Data loss when using save-as in a yellow-bar component editor

• AP-20461: Column Expressions node: Inconsistent results when using arrayReverse

• AP-20346: Decompress Files node: May fail on workflowset.meta files

• AP-20304: SSL certificate of standard server installations is not recognized any more

by AP

• AP-20038: Repeated prompts for server password

• AP-20018: Node settings map entry order not preserved on copy & paste

• AP-19896: Call Workflow (Table Based) fails with the current mountpoint option in the

Mountpoint Connector

• UIEXT-1055: Table header not aligned if scrollbar is present

• UIEXT-1037: Statistics view shows statistics rounded

• UIEXT-1008: Selection gets cleared when opening TableView with dialog

• UIEXT-773: Table view shows wrong row numbers when filtered

• UIEXT-741: Table view displays wrong result on fast filter changes

• UIEXT-740: Dialog doesn’t open if settings are invalid

• UIEXT-669: Table View: column types aren’t properly updated on column selection

• UIEXT-662: Clear filter does not update number of visible rows

• UIEXT-661: Filters in table not working correctly with activated lazy loading

• NXT-1728: Fix startup routine for existing workspaces

• NXT-1490: Configuration nodes can’t be added in a component

• NXT-984: Zoom in shortcut not properly detected depending on keyboard layout

• AP-20683: Row to Column Header node: Duplicate row id when using the columnar

backend

• AP-20680: Custom/KNIME URL file system ignores query parameters in

mountpoint/workflow/space-relative URLs

• AP-20669: Column Rename node: Cannot cast each column to string when using the

columnar backend

• AP-20661: Python nodes: Incompatible port type error is not user friendly

• AP-20654: Workflow Output node: Does not return data when executed and loaded

from workflow written in AP 5.0.1 or earlier

• AP-20589: Tables created by RowContainer aren’t tracked by local data repository

• AP-20570: Use LongUTFDataInput and Output when serializing DictEncodedDataCells

in Columnar Backend
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• AP-20560: Shared Component KNWF files are deleted when opened with AP

• AP-20501: (Python) Multiline node parameter descriptions do not dedent the

description, instead the indentation formats the text as code

• AP-20472: (Python) Extension bundling scripts do not check for errors when

downloading packages

• AP-20450: Kerberos constrained delegation should use domain_realm settings to

determine target service realm

• AP-20430: Mountpoint Connector node: Hub/server executor cannot resolve file

• AP-20427: (Python) Exception messages causing failure to parse Pure Python

extensions don’t propagate to KNIME console

• AP-20395: Container Input (Repository Event) node: Errors due to incomplete feature

installation

• AP-20390: Kerberos constrained delegation should not use account ID for for

impersonation in KNIME Business Hub

• AP-20382: SAP Reader (Theobald) node: Ignores lines that start with #

• AP-20305: Call Workflow nodes: Support hub space paths when setting the callee via

flow variable

• AP-20227: Nominal Row Filter Configuration node: Configuration is occasionally not

accepted in dialog

• AP-20214: Some nodes with Web UI throw an NPE if a table without columns is

connected

• AP-20195: SSH Connector node: Deadlock when multiple nodes read from the file

system

• AP-20185: Configuration (NodeSettings) underneath NameFilterConfiguration might

load as null

• AP-20135: Component update fails silently if an

UnsupportedWorkflowVersionException occurs

• AP-20114: File Upload Widget does not work on KNIME Hub

• AP-20073: Call workflow nodes fail if job takes longer than 1 minute to load on hub

• AP-20061: Table Reader node: Support hub space paths when setting the file via flow

variable

• AP-20049: Call Workflow (Row Based): Does not delete auxiliary jobs on server if

discard successful jobs is false

• AP-20006: Loading node repository may run into race condition

(ExceptionInInitializerError)
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• AP-19993: Arm64 Mac build (M1) is missing in '-Xmx' memory parameter in knime.ini

• AP-19953: Call Workflow nodes: Hub execution not supported without connector node

when the workflow is running on the Hub itself

• AP-19895: Call Workflow (Table Based) relative to option changes after the workflow is

reopened

• AP-19874: Component updates: No proper error message popup when checking for

updates fails

• AP-19863: Birt Reporting: "Web Viewer" option not displaying properly

• AP-19800: Call Workflow nodes: NoSuchFileException in the callee path when

executing workflows on the Hub from the KNIME Explorer

• AP-19792: Call Workflow Service node: Cannot be used in hub yellow bar editor

• AP-19751: Create Version Node does not check if the upstream space connector is

setting a version

• AP-19634: File handling connector nodes do not support workflow credentials

• AP-19533: Semantic Web nodes do not support proxy settings

• AP-19418: SharePoint Online Connector node: Fails when working directory is

controlled via flow variable that does not start with "/"

• AP-18808: Remove bundled Athena driver

• AP-18770: Fix at setting in a extended dataframe containing lists and sets

• AP-18708: Azure Data Lake Storage Gen2 Connector is failing to process proxy bypass

list

• AP-18025: Percentage cell renderer uses comma as decimal separator

Nodes changing in KNIME Analytics Platform 5.1.0

New Nodes:

• OAuth2 Authenticator (Password)

• OAuth2 Authenticator (Client Credentials)

• OAuth2 Authenticator

• Box Authenticator

• Box Connector

• Molecule Widget (Labs)

• Google Analytics Connector (GA4)
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• Google Analytics Query (GA4)

• Report PDF Writer (Labs)

• Report HTML Writer (Labs)

• Report Concatenate (Ports) (Labs)

• Report Concatenate (Table) (Labs)

• Text View (Labs)

• Container Input (Repository Event)

• Version Creator

• Service Deployment Creator

• Data App Deployment Creator

• Number Format Manager

• Row Aggregator

• String Replacer (Dictionary)

• Value Lookup

• Cell Extractor

• Table Cropper

• Table Splitter

• Table Updater

• Cell Updater

• Scatter Plot Matrix

• Parallel Coordinates Plot

• Sunburst Chart

• ROC Curve

Nodes replaced, old nodes deprecated:

• Service Deployment Creator (deprecated)

• Space Version Creator (deprecated)

• Column Rename (deprecated)

• String Replace (Dictionary) (deprecated)

• Cell Replacer (deprecated)

• Twitter Streaming (deprecated)
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• Color Appender (deprecated)

Nodes declared legacy:

• JFreeChart (multiple nodes)

• DeepLearning4J (multiple nodes)

• Run R Model in Microsoft SQL Server (multiple nodes)

• Interactive Table (legacy)

• Interactive Histogram (legacy)

• Histogram (legacy)

• Box Plot (legacy)

• Line Plot (legacy)

• Parallel Coordinates (legacy)

• Scatter Plot (legacy)

• Scatter Matrix (legacy)

• Pie chart (legacy)

• Interactive Pie chart (legacy)

• Conditional Box Plot (legacy)

• Lift Chart (legacy)

• HiLite Table (legacy)

Nodes renamed:

• ROC Curve (local) → ROC Curve (legacy)

• Enrichment Plotter (local) → Enrichment Plotter (legacy)

• Crosstab (local) → Crosstab (legacy)

• Variable to Credentials → Variable To Credentials

• Variable to Table Column → Variable To Table Column

• Variable to Table Row → Variable To Table Row

• Table Row to Variable → Table Row To Variable

• Table Column to Variable → Table Column To Variable

• Microsoft Authentication → Microsoft Authenticator

• Amazon Authentication → Amazon Authenticator
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• Google Sheets Connection → Google Sheets Connector

• Statistics (Labs) → Statistics

• Line Plot (Labs) → Line Plot

• Box Plot (Labs) → Box Plot

• Scatter Plot (Labs) → Scatter Plot

• Histogram (Labs) → Histogram

• Heatmap (Labs) → Heatmap

• Pie Chart (Labs) → Pie Chart

• Density Plot (Labs) → Density Plot

• Stacked Area Chart (Labs) → Stacked Area Chart

• Bar Chart (Labs) → Bar Chart

• Table View (Labs) → Table View

• Double To Int → Double To Integer

• Extract Column Header → Column Name Extractor

• Insert Column Header → Column Renamer (Dictionary)

• Pivoting → Pivot

• Unpivoting → Unpivot

• Top k Selector → Top k Row Filter

• Transpose → Table Transposer

• Row to Column Header → Row to Column Names

• Google Authentication (API Key) → Google Authenticator (API Key)

• Google Authentication → Google Authenticator

• Google Analytics Connection → Google Analytics Connector (legacy)

• Google Analytics Query → Google Analytics Query (legacy)

• Generic JavaScript View → Generic JavaScript View (JavaScript)

• Table View → Table View (JavaScript)

• Table Editor → Table Editor (JavaScript)

• Scatter Plot → Scatter Plot (JavaScript)

• Line Plot → Line Plot (JavaScript)
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• Lift Chart → Lift Chart (JavaScript)

• ROC Curve → ROC Curve (JavaScript)

• Decision Tree View → Decision Tree View (JavaScript)

• Tag Cloud → Tag Cloud (JavaScript)

• Tile View → Tile View (JavaScript)

• Heatmap → Heatmap (JavaScript)

• Conditional Box Plot → Conditional Box Plot (JavaScript)

• Stacked Area Chart → Stacked Area Chart (JavaScript)

• Sunburst Chart → Sunburst Chart (JavaScript)

• Bar Chart → Bar Chart (JavaScript)

• Box Plot → Box Plot (JavaScript)

• Histogram → Histogram (JavaScript)

• Pie/Donut Chart → Pie/Donut Chart (JavaScript)

• Parallel Coordinates Plot → Parallel Coordinates Plot (JavaScript)

Community Extensions

Trusted Partner Extensions

One change currently:

Extension Contributor Changes

Symanto Brain Symanto Available - New since 2023,

also available for 4.7

Metadata-Hub Extension GRAU DATA Available - New since 2023,

also available for 4.7

Spotfire File Nodes TIBCO Spotfire Available soon

Trusted Community / Open Source Extensions

Extension Status

Generic Workflow Nodes for KNIME Available

KNIME Analytics Platform Installation Guide

© 2023 KNIME AG. All rights reserved. 24

https://hub.knime.com/symanto%20team/extensions/com.symanto.brain.feature/latest
https://hub.knime.com/grau%20data%20team/extensions/graudata.features.mdh_extension/latest
https://hub.knime.com/andrewberridge/extensions/com.tibco.ext.spotfire.feature/latest


Extension Status

KNIME Groovy Scripting extension Available

KNIME HCS Tools Available

KNIME Python Scripting extension Available

KNIME R Scripting extension Available

KNIME Shapefile Support Available

Lhasa Available

OpenMS Available

RDKit Nodes Feature Available - Changes - 5.1.0 did not work on

Linux due to a regression of KNIME

Analytics Platform (fixed in 5.1.1)

Slack Integration Available

Continental Nodes for KNIME Available

Genentech Available

Geospatial Analytics Extension Available - Changes

Neo4J Available

Vernalis KNIME Nodes Available - 5.1.0 did partially not work on

Linux due to a regression of KNIME

Analytics Platform (fixed in 5.1.1)

KNIME Image Processing Available

KNIME-CDK Available

KNIME AI Extension Available - New since 2023

Web Interaction Available - New since 2023

KNIME Nodes for Scikit-Learn (sklearn)

Algorithms

Available - New since 2023

DYMATRIX Not available anymore
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Experimental Open Source Extensions / Experimental Community Extensions

Extension Changes

AF Utility Nodes Available

CIR KNIME Integration Available

KNIME Matlab Scripting extension Available

Process Mining Extension Available

Apprise Nodes Available

PIA Available

Erlwood KNIME Open Source Available

Word2Vec Available - New since 2023

Indigo KNIME integration Available - Not working on MacOS because

of a bug in Indigo

AI.Associates Signal Processing Available

Enalos Nodes for KNIME Available

MMI Data Analytics Nodes Available

PM4KNIME Available

Redfield BERT Nodes Available

Redfield NLP Nodes Available

3D-e-Chem KNIME nodes Available soon

FSK-Lab Available soon

KNIME Spatial Processing Nodes Available soon

de.NBI - CIBI Extension Not available anymore

JMSConnector for KNIME Not available anymore

OCHEM Integration Nodes Not available anymore
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Extension Changes

openBIS Knime Nodes Not available anymore

RapidMiner Integration for KNIME Not available anymore

Self-Tuning Association Rules for KNIME Not available anymore

HTS Data Mining Not available anymore

KNIME Portable Format for Analytics (PFA)

Support

Not available anymore

CheS-Mapper-Node extension for KNIME

Workbench

Not available anymore

Cumulocity Connector Not available anymore

TreeSHAP - Explainable Machine Learning in

KNIME

Not available anymore

SeqAn Not available anymore

KNIME Analytics Platform 5.1.1

Release date: September 14, 2023

Enhancements

• BD-1239: (Big Data Extensions): Spark 3.4 support

• AP-19146: Python Node Extension: Support dialog rules

• BD-1243: (Big Data Extensions): Support insert/update/delete SQL statements in

Databricks and Hive JDBC connections

• NXT-1934: Drag and drop an extension

Bug Fixes

• AP-20968: REST DELETE node uses 'Content-Type: text/xml' request header if none was

set
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• AP-20843: Component Execution: Unclosed loops can executed in 4.7 but no longer in

5.1 (requires switch to enable backward compatibility)

• AP-20810: Corrupt workflowset.meta Prevents Workflow Loading

• AP-20754: Updating to latest 4.7 AP is not possible (due to 5.1 Download banner)

• AP-20749: Apache CXF’s HttpClient-SelectorManager threads run indefinitely

• AP-20744: BigGroupByTable fails to group "unusual" cell types

• AP-20730: SharepointOnline Connector cannot read/write to folders which contain

spaces in the path

• AP-20583: XGBoost Libs no longer working in KNIME 5.1.0 Nightly/Linux (after Eclipse

Update?)

• AP-20949: REST Web Service nodes: KNIME-wide settings do not apply without

reopening the dialog

• AP-20900: Using HTTP/2 for Workflow Download Fails on MinIO (KBH/DatA-Hub)

• AP-20794: No node recommendations for python nodes

• AP-20719: Columnar Backend: ClassCastException with XMLCells in loops

• AP-20712: KNIME Server Connector: Typo in error message for unknown host

• AP-17672: Kafka Consumer cannot handle null keys

• NXT-1929: Nodes followed by a component at the begining of a workflow are not

executable in Modern UI

• NXT-1800: HTML is displayed in modern workflow annotation inside the classic user

interface

• UIEXT-1072: Resources passed through CEF middleware get corrupted

KNIME Analytics Platform 5.1.2

Release date: October 18, 2023

Enhancements

• AP-21235: Check configuration of deployment when version is changed

• AP-21050: String Replacer (Dictionary) with new default with regard to iterative

application of replacement rules

• AP-21019: Support pagination in AP Explorer
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• AP-20893: Snowflake driver updated to version 3.14.1

• NXT-2071: Update to CEF 106.0.19

Bug Fixes

• AP-21065: Adding file system input port removes outgoing connections to metanodes

• AP-21046: AP: can’t delete multiple jobs in one go

• AP-20799: Shared Component in not-shared Component not updated

• AP-21245: Content Retriever node fails to retrieve full Page content

• AP-21244: REST Client nodes do not properly load proxy settings w/ auth

• AP-21049: Salesforce client nodes not properly closing "web client" instance (thread

exhaustion after millions of requests)

• AP-21038: Snowflake DB Loader fails in KNIME Executor if local file access is disabled

• AP-21036: Memory alert while reading into SharedReadBatchCache causes deadlock

• AP-20984: Failing Python node kills PythonConnectionPortObject even if the node did

not create the connection

• NXT-2080: Saving workflow calls "saveInternals" twice after moving a node

• NXT-2072: Too many threads "comm-pool-thread-1" getting generated (but not

discarded) when generating images in a loop

• NXT-2037: Overwriting a local folder with a workflow from Hub

• NXT-2036: D&D data files from Hub space to workflows in Modern UI does not add true

path

• NXT-1927: Execute button is above the table

Known issues

• AP-21237: Splash screen is displayed upside down

When starting the application in macOS Sonoma (version 14) the splash screen is

displayed upside down. This was introduced via a macOS background image rendering

bug which affects all Eclipse-based RCP apps.
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KNIME Analytics Platform 5.1.3

Release date: February 23, 2024

Enhancements

• AP-21786: Use URLConnection instead of HttpClient for REST requests (improves

stability for concurrent requests)

• AP-21605: Support ""org.apache.cxf.transport.http.forceURLConnection"" system

property to avoid CXF thread exhaustion

• AP-21579: Add configuration option for 'receiveTimeout' in Salesforce Query nodes

• AP-21415: Add CID to mail attachments in Send Email node

• AP-20946: Robustify server address input validation in `AdditionalInformationPanel`s

• NXT-2160: Update to Equo Chromium 106.0.21

Bug Fixes

• AP-20588: Sorter node does not handle missing flow variable for alphaNumStringComp

(kudos to @richards99 for reporting 1)

• AP-21398: Row Aggregator miscalculates weighted average (wrong formula) (kudos to

@Bytecrawler for reporting 1)

• AP-21237: macOS Sonoma: Splash screen is displayed upside down (kudos to

@mlauber71 for reporting 1)

• BD-1251: (Big Data Extensions): DB Loader with file system connection fails with

""Config for key filter_mode not found"" exception (kudos to @mlauber71 for reporting

1)

• AP-22004: DB Loader fails for Snowflake if the KNIME workspace is located on a

shared drive on Windows

• AP-21539: Metanode to Component conversion fails under special circumstances

• AP-21081: File Download Widget creates an empty file if the file name has a 'space'

character in it

• AP-21059: Decision Tree View (JavaScript): encoding issues on Windows

• AP-21735: Missing node message duplicated for each missing node

• AP-21617: Execessive thread creation when loading many jobs

• AP-21561: Update pyarrow in knime-python-base=5.1 to 14.0.1 to prevent CVE-2023-
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47248

• AP-21446: Send to Tableau Server node opens up large amounts of ports and does not

close them on Windows Server

• AP-21445: Agent Prompter fails on Azure OpenAI with KeyError

• AP-21393: Predictor nodes don’t keep original row IDs

• AP-21375: GPT4All .gguf models do not work

• AP-21371: Missing description in Azure Authenticator

• AP-21366: Vector Store Retriever fails if the query table has multiple columns

• AP-21252: xlink:href attributes in HTML coming from WebpageRetriever cause errors in

XML parser

• AP-21223: Default off-heap memory size strategy often exceeds available RAM when

combined with Xmx

• AP-20299: Duration in Table View (classic & modern) sorted like strings

• NXT-2130: Stopping a loop execution takes (much) longer in the new UI than in the old

UI
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